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Logicode (Ver. 5.0)

	Fundamentals of Computer

 

1.	 a. (iii)		 b. (iii)	 c. (iii)	 d. (iv)	 e. (ii)
2.	 a. Intel 4004		  b. Gaming Console	
	 c. Digital Computer		  d. Embedded Computer
	 e. Supercomputers
3.	 a. F		  b. T	 c. F	 d. T	 e. F
4.	 a. Third generation		  b. Analog computer		 c. CPU
	 d. Laser printer		  e. Projector
5.	 a. Some distinct features of Supercomputers are:
		  ●  �A supercomputer consists of a large number of processors and also occupies a huge 

amount of space. 
 		  ●  �Calculations that a personal computer performs in three weeks can be performed by a 

supercomputer in minutes. 
	 b. 

A mainframe computer is a massive computer that 
occupies a huge amount of space and often fills an 
entire room. Mainframe computers usually have 
multiple terminals connected to them.

Microcomputers were earlier termed personal 
computers. A personal computer consists 
of a CPU, computer memory (primary and 
secondary), input and output devices. 

Microcomputers Mainframe computers

	 c. An embedded computer is a special type of microprocessor-based system that is developed 
for performing a specific task. Digital camera and microwave are the examples of embedded 
computers.
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	 d. A gesture recognition camera is a motion input device. Motion input lets the user guide the 
on-screen elements using air gestures. Air gestures involve moving your body or a handheld 
input device through the air. With motion input, a device containing a camera detects your 
gestures and then converts them to a digital signal that is sent to a computer or game device. 

6. 

The printers that do not have direct contact 
between the print head and paper are known as 
non-impact printers. 
Example: Laser printer and Inkjet printer.

Printers that have direct contact between the 
print head and paper are known as impact 
printers. 
Example: Dot matrix printer.

Impact Printers Non-impact Printers

7.	 a. A hybrid computer would be the most suitable for this purpose.

	 b. The microprocessor is the component which has primarily contributed to the reduction in 
size of this complex machine called a computer. A microprocessor is an integrated chip on 
which the entire CPU (Control Unit and ALU) is fabricated.

	 c. An analog computer is suitable for this task because it operates by measuring continuously 
changeable physical quantities such as temperature, pressure, and water flow, and displays 
the output as a graph.

	 d. A hybrid computer is being used here as it combines the speed of an analog computer for 
measuring the heartbeat with the accuracy of a digital computer for displaying the results.

	 e. The research center should use a supercomputer because it is a very powerful machine capable 
of performing complex scientific calculations at extremely high speeds. It can perform tasks 
that would take a personal computer weeks to complete in just a few minutes.

	Formatting in PowerPoint

 

1.	 a. (iii)		 b. (ii)	 c. (iii)	 d. (ii)
2.	 a. Picture	 b. Attractive	 c. Combination	 d. Insert
3.	 a. WordArt	 b. Resizing handles	 c. Rotation handle	 d. Insert tab
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2.

4.	 a. 1  Click on the Design tab.
		  2  Click on the Format Background option.
		  3  Select the Picture or texture fill option.
		  4  Click Apply to All.
	 b.	Templates are well-developed presentations that contain layouts, theme colours, fonts, effects, 

background styles and samples for the content.
	 c.	To use a template in a presentation, follow the given steps: 
		  1  Click on the File tab. 
		  2  Click on New option. 
		  3  Type a keyword in the search box and click on the Search icon. 
		  4  Select the template you like and click on the Create. 
	 d.	WordArt is a text style that can be applied to the text to make a presentation more attractive.

5.	 a.	Use the Shapes tool under the Insert tab.

	 b.	Use the WordArt command from the Shape Format tab.

	 c. To apply the selected background colour to all the slides, Asha should click on the Apply to 
All option. 

	 d. The student should use Resizing handles and Rotation handle to adjust the size and direction 
of the picture.

	 e. WordArt is a text style that can be applied to the text to make a presentation more attractive.

	Animation and Transition in PowerPoint

1.	 a. (ii)		  b. (iii)	 c. (iii)	 d. (iv)	 e. (iii)
2.	 a. Right	 b. SmartArt	 c. Transition	 d. Animation
3.	 a. F		  b. F	 c. F	 d. T
4.	 a. Media	 b. Motion Paths	 c. Animation Pane	 d. Insert
5.	 a.	Animation is a visual effect that gives us the ability to move objects like text, pictures, charts, 

etc., in any direction in the slideshow. Animations can easily develop the interest of the audience.
	 b.	Animation is applied on objects whereas Transition effects are applied on slides. Transition 

effects make the switch from one slide to another slide seamless, else the abrupt switching 
of slides can be unpleasant during a presentation.
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	 c.	There are four kinds of animations in PowerPoint. These are Entrance, Emphasis, Exit and 
Motion Paths. 

	 d.	 1  Click on the Insert tab.
		  2  Click on the Video option in the Media group.
		  3  Select This Device option.
		  4  Navigate the folder to find a video file.
		  5  Select the video file and click on the Insert button.
6.	 a.	Use the Animation feature in PowerPoint.
	 b.	Use the Transition feature.
	 c. Neha should use Entrance, Emphasis and Exit animation effects to achieve this.
	 d. The Animation Pane in PowerPoint will allow Rohan to view and change the sequence of 

animation effects on the slide.
	 e. The teacher should use Slide Transitions and set the timing for the slide to change automatically, 

along with adding a sound effect under the Transition tab.

	Excel 2021—An Introduction

 
1.	 a. (ii)		  b. (iii)	 c. (i)	 d. (iii)	 e. (iii)
2.	 a. Cell		 b. Quick Access Toolbar	 c. Workbooks
	 d. Active	 e. Save
3.	 a. File tab	 b. Name Box	 c. New option under File tab
	 d. At the bottom of the workbook
4.	 a.	A workbook is a file in Excel that contains one or more worksheets. A worksheet is a single 

page where you can enter and work with data in Excel.
	 b.	Formula bar shows the content of the active cell. If a cell contains text or fixed number, the 

content in the formula bar is same as seen in the cell.
	 c.	We may enter data in the form of numbers or text. Excel automatically left-aligns the text 

data and right-aligns the numbers in a cell.
	 d.	To add a new worksheet, follow the given steps:
		  1  Right-click on the Sheet tab.
		  2  Select the Insert option.
		  3  Click OK button.

4.

5.	 a.	Rohan should look at the Formula bar.
	 b.	Click on the + sign next to the worksheet tabs or right-click at sheet tab and choose Insert.
	 c. Excel automatically left-aligns the text data and right-aligns the numbers in a cell. 
	 d. The Name Box on the Excel window will help him identify the selected cell.
	 e. Ravi should add a new worksheet by clicking on the + (plus sign) on the Worksheet tab. To 

rename he should right-click on the worksheet and select the Rename option. Type the new 
name of the worksheet and press the Enter key.

	Editing in Excel 2021

 

1.	 a. (i)		  b. (ii)	 c. (i)	 d. (ii)	 e. (ii)
2.	 a. Undo	 b. Redo	 c. Range	 d. Delete	 e. Autofill
3.	 a. F2 key	 b. Select All triangle	 c. Home tab	 d. Quick Access toolbar
	 e. Fill Handle
4.	 a.	To select a row, place the mouse pointer on the row header of the row to be selected. The 

mouse pointer will change to an arrow. Now click on the row header and the entire row gets 
selected.

	 b.	Autofill feature allows us to quickly fill cells with repetitive or sequential data. Data can be 
filled down in a column or across a row.

	 c.	 1  �Right-click on the row number above or below where you want to add a new row and 
select Insert option.

		  2  Select the desired option.
5.	 a.	Undo command.
	 b.	Kazim can use the AutoFill feature by typing 1 and 2, selecting both, and dragging the fill 

handle.
	 c. Mansi should select the cell and press the F2 key on the keyboard. The cursor appears in the 

cell. Now, she can edit the content. 
	 d. For adding a new column in Excel, Priya should follow the given steps:
		  1  Right-click on the column header where she wants to insert the new column (either to 

the left or right of the selected column).
		  2   From the context menu, select the Insert option.
	 e. Mayank should use Redo command to do so.
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	E-mail and Malware Safety

 

1.	 a. (i)		  b. (ii)	 c. (iii)	 d. (iv)
	 e. (ii)		  f. (iv)
2.	 a. Domain	 b. Carbon 	 c. Compose	 d. Attachments
	 e. Signing Out	 f. Malware	 g. Norton
3.	 a. Sending emails	 b. Inbox	 c. Subject	 d. Username
	 e. Macro virus	 f. Trojan horse
4.	 a.	E-mails have various advantages, some of which are: 
		  •  An e-mail can be sent anytime and from anywhere in the world. 
		  •  An e-mail can be sent to many people at a time. 
		  •  An e-mail can be easily forwarded to anyone without typing it again. 
	 	 •  Sending an e-mail is fast in comparison to traditional mail.
	 b.	Cc stands for Carbon Copy. We type the e-mail address of the people we want to send a 

copy of the e-mail to. 
		  Bcc stands for Blind Carbon Copy. If we want to keep someone hidden from all the other 

recipients of our message, then their e-mail address is written here.
	 c.	To attach a file to an e-mail, follow the given steps:
		  1  Click on the Attach files option.
		  2  Browse and select the file you want to attach.
		  3  Click on Open button.

Once the file is attached, it will be displayed at the bottom of the New Message window. 
	 d.	A worm is a self-replicating malware that spreads through computer networks without human 

intervention. Whereas, a virus is designed to damage data and disrupt computer operations 
by attaching to files, infecting the system when the file is copied.

	 e.	Symptoms of Worms are as follows:
		  •  The memory of the computer gets occupied and storage capacity lowers. 
		  •  Programs start crashing and do not run properly. 
		  •  Files get deleted and replaced automatically on the computer.
5.	 a. Akshat can use Attach files option in an e-mail.
	 b. Namiya can do this using the Forward option.
	 c. The type of malware causing this could be a virus.
	 d. Mohan should avoid opening the attachment and delete the email immediately. 
	 e. Aarav should install antivirus software to protect his computer from viruses.

6. 	Digital Storytelling

1.	 a. (ii)		  b. (i)	 c. (ii)	 d. (iii)	 e. (iv)

2.	 a. Problem	 b. Character	 c. Solve	 d. Clipart	 e. Export

3.	 a. T		  b. T	 c. F	 d. F	 e. T 
4.	 a.	There are two ways you can add characters to your story: 
		  1  Adding character using clipart. 
		  2  Creating custom character.
	 b.	The steps to add a character using clipart are:
		  1  Open the Sketchpad website and start a new project.
		  2  Click on the Clipart tool.
		  3  Click the Choose Graphic drop-down arrow to open the clipart box.
		  4  �Type a keyword in the search box and select the required character and place it on the 

canvas. 
	 c.	The steps to add dialogues in a digital story are:
		  1  Add dialog box using Clipart.
		  2  Click on the Text tool. A text box appears on the canvas.
		  3  Type the text in the text box.
		  4  Place the text above the dialog box.
	 d.	The three main parts of a story outline are:
		  •  Beginning: Introduce the characters and the problem. 
		  •  Middle: Show the challenges and how the characters try to solve them. 
		  •  End: Show how the characters overcome the challenge and what they learn.

5.	 a.	To make the characters of the story Ritu must think of the following questions: 

		  •  Who are your main characters? Think about their personalities. 

		  •  What do they look like? Describe their appearance. Are they big, small, funny, or serious? 

		  •  �What do they want? Every character should have a goal or something they desire. This 
goal will drive your story forward.

	 b. Kritika should create an outline that shows the beginning, middle and end of the story to 
organise her ideas clearly before designing the digital story.

7.
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	 c. Priyansi should create her own characters using shapes and colours or use clipart, and design 
a suitable background that sets the scene and supports the story.

	 d. The student should add dialogues using dialog boxes and the Text tool so that the characters 
can express ideas clearly and the story becomes more engaging.

	 e. Yuvan should duplicate the first scene, create a new page and then change the dialogues 
and background as needed to continue the story.

	Scratch Meets AI

 
1. 	 a. (iii)		 b. (i)	 c. (ii)	 d. (iv)
2.	 a. F 		  b. T	 c. T	 d. F
3.	 a. Multiple	 b. Broadcast, Receive	 c. Variables	 4. Talk
4.	  a. Sprite Info pane 		 b. Add Extension,	 c.  Add Extension
5.	 a.	�Broadcast and Receive blocks allow sprites to communicate with each other without being 

directly connected. This is useful for controlling different parts of a story or game.
	 b.	�Variables can store numbers, text or other information that needs to be updated or referenced 

throughout your project.
	 c.	� The translation is possible through a collaboration between Scratch and Google. It internally 

uses Google Translate to perform the translations.
	 d.	�The Video Sensing extension lets you use your webcam to control your project. It can detect 

movement in front of the camera and use it to make things happen in the game, like moving 
a sprite or triggering an action.

	 5.	Difference between Global Variables and Local Variables:

Global Variables Local Variables

Global variables are created on any sprite 
and can be accessed or modified by other 
sprites used in the project.

Local variables are created for a specific sprite 
and can only be used by that sprite.

These variables are created by choosing 
‘For all sprites’.

These variables are created by choosing ‘For 
this sprite only’.

6.	 a.	�Vasudha should use Broadcast and Receive blocks to achieve this.
	 b.	�Swapnil should click on the Add Extension button and choose the Video Sensing extension 

to do so.
	 c. Ritika should use Broadcast and Receive blocks from the Events block category to do so. 

8.
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	 d. Pankaj can use variables in Scratch to store and update the score during the game.
	 e. Neel should add Video Sensing extension to his project to achieve this.

	   Future of Artificial Intelligence

 

1.	 a. (ii)		  b. (i)	 c.  (ii)	 d. (ii)	 e. (iii)
2.	 a. T	 b. T	 c. T	 d. F	 e. F
3.	 a.	AI can revolutionise how traffic can be controlled and managed in cities. Congestion can be 

reduced by route selection, predictive alerts and route deviation.
	 b.	Smart highway is a type of road in which AI-enabled devices are used for monitoring the 

condition of the road, traffic levels and the speed of vehicles. 
	 c.	A smart home is an AI-enabled home lets us turn on our lights, play favourite music or change 

our room temperature, by tapping the app on our smartphones. We can have our coffee 
ready when we wake up, automatically turn on and off ACs, lights, fans, etc.

	 d.	When someone tries to break into your home through the door or window, the motion 
sensor will send notifications to you. You will get instant alerts on your smartphones when 
your home is hit by fire, flood or any other disaster. You can configure a central automation 
system to take necessary actions instantly.

4.	 a.	Rohit can use AI-enabled CCTV surveillance systems.
	 b.	AI-powered chatbot or virtual assistant that uses natural language processing (NLP) to 

understand customer queries and provide instant, accurate responses 24/7 can be used by 
Gaurav to achieve this.

	 c. The city authority should implement AI-based traffic management system to achieve this.
	 d. The solution is AI-based smart home using smart devices controlled by smartphones.
	 e. The AI-based technology being used is autonomous vehicles (self-driving cars).

9.


